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GPR-SLICE Subscribers,      

We would like to welcome the following organizations to the GPR-SLICE 

community: & T C 

1. Dept of History, Geography and Philosophy, University of Cadiz, Spain 
2. Everick Heritage, Brisbane, Australia 
3. The Manufacturing Technology Center, Coventry, UK 
4. Center for Civil Protection, University of Florence, Italy 
5. Coretec, Korea 
6. Institute of Ecology, University of Tallinn, Estonia 
7. Dept of Geophysics, Chungnam National University, Korea 
8. Geophysx Jamaica Ltd., Kingston 
9. Edwards-Pitman, US 
10. Hydrogeophysics Branch, United States Geological Survey, Menlo Park, CA 
11. Freelance Geoscience Consultant, Bandung, Indonesia 
12. United States Army Corps of Engineers, Ft Worth, Texas 
13. UXOMAP, Paris, France 
14. International Atomic Energy Agency, Vienna 
15. Ryobi Geosystem Pte Ltd, Singapore 
16. Fukada Geological Institute, Kyoto University, Japan 



17. Applied Geotechnologies Research Group, University of Vigo, Spain 
18. University of Science and Technology, China 
19. GPRS, Toledo, Ohio 
20. Inner Mongolia University, China 
21. Hirani Group, New York 
22. IAC Surveying and Contracting, Dubai, United Arab Emirates 
23. Dept of Anthropology, University of Illinois at Urbana-Champaign 
24. Dept of Energy and Mineral Resource Engineering, Sejong University, Korea 
25. 2 Ladies Locating and GPR in Kirkland, Washington 
26. Space X 
27. Exploracion Perforacion y Estudios del Subsuelo, Mexico 
28. Research Center for Humanities, Hungary 
29. Tennessee Valley Archaeological Research, Huntsville, Alabama 
30. More og Romsdal fylkeskommune, Norway 
31. OSL Hungary Ltd 
32. Geoarch Solutions LLC, Knoxville, Tennessee 
33. Geomines, France 
34. ENC d.o.o., Serbia 
35. Dept of Earth Sciences, Montana State University 
36. LVR - Amt fur Bodendenkmalpflege im Rheinland 

     Multichannel licenses were included to the University of Cadiz, The 

Manufacturing Technology Center, Chungnam National University, UXOMAP, 
Kyoto University, GeoMines and LVR.  Bridgedeck license were included to the 

University of Cadiz, University of Tallinn, Chungnam National University and 
OSL Hungary. GPRSIM licenses were delivered to the United States Geological 

Survey in Menlo Park. 

 

 

Major features and options added to GPR-SLICE include:     

 

• Amplitude equalization filter 

• Line drawing on multi-display radargrams using XYpoints 

• Bridgedeck module improved with multiple layer detection/retrieval/editing 

• ANG survey displays with 3-tiered labeling 

• Display and compilation of all user marks in OpenGL Volume Draw menu 

• Scrolling and selection of (long) GPS radargrams in OpenGL with a user set 

scan length 

• Number of units to extend time slice grid and to preserve fractional 

start/end 

• Parsing long GPS radargrams 

 



Amplitude Equalization 

     A new option for regaining radargrams based on the inverse root mean 

square across a moving sample length has been added to the Filter menu 

(Figure 1). The method works on every scan individually and creates a unique 

gain based on a sample window length centered on each pulse value on the 

radar scan. The gain value applied to the pulse is the binary resolution of the 

radargram divided by the root mean square of all the data values in the sample 

window. The effect of the filter is to equally amplify all parts of the radar scan. 

The gaining even works in areas where there is no data essentially seen. Here 

the application of the filter is made on a dc/drift - wobble removed radargram 

only without any range gain or bandpass.  

     The sample length has a strong influence in the outcome of the filter. The 

longer the filter the closer a bandpassed+agc radargram looks like the 

amplitude equalized radargram. Figure 2 shows comparison of an original 

radargram, and equalization lengths of 20, 120, and 220 samples. From a 

dataset provided by Aero 360 from the Philippines for a drone GPS survey with 

zig-zag lines, the initial areas at the beginning and the end of the original 

bandpassed+agc radargram, no measurable reflectors can be seen; the 

amplitude equalization filter nonetheless "discovers" and amplifies even the 

smallest digital reflections recorded. (These areas may be where the drone is 

way above ground and flying to and from the start/end programmed GPS path 

and thus do not have subsurface reflections recorded). The effect of the filter 

on time slices can be dramatic. In the example shown amplitude equalization 

can highlight weaker features as well de-amplify features which are dominate. 

The motivation for this filter was primarily developed for the seismic industry 

in which mapping all the stratigraphy horizons is crucial to discover all the 

horizon layers where reserves are present. The filter might be used to enhance 

imagery made for large multichannel dataset areas where significant ground 

changes between large areas show significantly different soil contrasts from 

simple amplitude maps. Amplitude equalization filtering can help to equalize 

contrast across the entire datasets. With all filtering some benefits and 

detriments will always exist even with the most common filters we apply to 

GPR data including background filtering, migration etc.  

 



 

Figure 1.  Location of the new Amplitude Equalization filter.  An overall gain value 

and the scan sample length can be set to create an RMS gain curve that is unique 

to each pulse. 

 



 
Figure 2.  A comparison showing different sample lengths used for the 

amplitude equalization filter.  The larger the sample length, the closer the 

filtered data can look similar to a single AGC gained radargram. 



Basic drawing functions on multi-display radargrams via XYpoints 

 

     After receiving multiple requests for drawing capabilities on radargrams, we 

placed in some very basic drawing capabilities. Launching the XYpoints menu, 

and then choosing the line checkbox, one can begin drawing lines on any 

radargram in the multi-radargram display (Figure 3). To end a line and start 

another line, one simply toggles the line checkbox off/on again to start a new 

line. Shutting off the line checkbox completely gives the traditional look of just 

showing the chosen points in the XYpoints dialog on top of the radargrams. One 

can chose a color for each drawn line as well as the line thickness which can vary 

from 1-100. With the dots checkbox highlighted and the line checkbox off, the 

user can draw dots on the profiles. Clicking the Save button is necessary to keep 

all the drawn objects and update the XYpoints.dat file. The drawings can be 

retrieved as all the drawing information resides in the XYpoints information file 

and resized if needed. 

 

 
 

Figure 3.  Examples of using the XY points menus to perform basic line 

drawings on the radargrams.  Individual line thicknesses and point number 

displays can be included in the drawings. 



Bridgedeck module improved with up to 5 multiple layer 

detection/retrieval/editing /compilation 

     For those that have the Bridgedeck module addition to GPR-SLICE, this menu 

has been enhanced to store up to 5 user defined layers (Figure 4). One can set 

the descriptor for 5 layers, and using the radio button next to the descriptor, 

begin the autodetection. The software will remember all the autodetection 

settings used to discover the desired hyperbolas or anomalies for each layer 

independently. The editing dialog has also been improved by allowing either 

insertion or deletion of the shown picks by clicking the desired action button, then 

right clicking to insert or delete the hyperbolas. 

     To get all the detected layers to appear in the dialog one checks on those 

layers desired to overlay and then the Import Layer button is clicked. On 

compilation of the detected layer the customized descriptor name is given to all 

the output filenames. In the example, the XYZ-RebarA1.dat file made is the 

detection for layer 1 of the depth to the rebar. These files and for every unique 

layer can then be gridded in the Grid menu. 

  

Figure 4. Improved Bridgedeck module showing up to 5 layers detections with 

unique naming and compilations.   The menu will also remember the detection 

settings for each layer that is active. 

 



ANG survey displays with 3-tiered labeling 

     As more and more surveys are being done in local grids and then converted 

to georeferenced ones, we have made it more convenient to generate imagery 

without having to convert to artificial GPS survey format. All "ANG" surveys are 

now shown with 3-tiered labeling - x, y and total range (Figure 5). In addition, 

the limitation of the requirement of converting ANG surveys to GPS ones prior to 

using the Horizon menu has been lifted.   

Note: X or Y or XY surveys can even be redefined as ANG surveys should one 

want 3-tiered labeling for this regular surveys. 

 

 
 

Figure 5.  3-tiered radargram labeling with x, y and total range is now active for 

all ANG surveys.   

 

 



Display and compilation of all user marks in OpenGL Volume Draw menu 

     A subscriber – Dan Keininger with Texas Cemetery Restoration - uses GPR on 

historic cemeteries and asked if it was possible to have all the user marks he 

inserted during his survey be shown in OpenGL. During the survey he stores user 

marks in front of known burials with headstones, and he wanted to be able to 

see these to better help him interpret all the data and particularly how the 

unmarked burials look in comparison. Currently, one can show the user marks 

on individual radargrams using the User Mark checkbox in the Options menu. A 

new option was added to the Grid 2D button in the listbox called User Marks 

which will compile all the user marks to sphere objects and display them in the 

OpenGL menu (Figure 6). The user can set the size of the spheres (diameter) as 

well as the desired color before importing the users marks into the drawing menu. 

Remember, one can always back up their current drawing with a unique name so 

that user marks or other drawn features can be imported into the menu as 

separate layers. 

 

Figure 6.  New option to compile all the user inserted marks into sphere objects 

using the Grid2D function and the User Mark listbox item. 



Scrolling of GPS radargrams in OpenGL with a user set scan length 

     GPR/GPS surveying is becoming more commonplace and users are often 

collecting longer and longer single-track GPS datasets.  An example of a super 

long GPS (drone) track collected by Aero Solutions 360 in the Philippines  is 

shown in Figure 7. One issue in displaying GPS radargrams in their full 3D extent 

is zig-zag single track surveys are difficult to look inside the track as front or rear 

portions block the visualization.  For this reason, a new scrolling 3D option was 

developed in OpenGL for GPS radargrams. The user can set the number of scans 

to examine and then clicking the r+/r- buttons one can increment and display 

that number of scans into the single track. The Store button can also be used to 

keep display lists of any number of desired portions of the track. The Bounce 

button can be engaged and will allow an "animation" of the GPS track. The 

animation will reverse itself after getting to the end of the track. 

 

Figure 7. New options to set a user defined scan length for GPS radargrams and 

using the r+ and r- buttons to scroll that many scans into the profile. 



Number of units to extend time slice grid and to preserve fractional 

start/end  

     Recently we were asked by Dan Bigman with www.LearnGPR.com if we could 

preserve the original xstart/ystart xend/yend values for a time slice grid set. 

Typically, when you are in the Grid menu and click the Help Set button the 

software will set the nearest lowest/highest integer so the grids start and end on 

integral locations.  To allow for fractional grid start/end points a new option was 

added to the Grid menu call XY Round#. With this option checked on and clicking 

Help Set the original fractional grid start/end points will fill the slots in the menu 

(Figure 8).  

     We have also gotten inquiries from users often with GPS datasets, why is 

GPR-SLICE cutting off the edges of gridmaps (Figure 9). The answer we normally 

give is because you are interpolating beyond the original track map!  If one wants 

to avoid that they can either reduce the Blanking Radius in the menu to prevent 

interpolation beyond that distance where data does not exist. Alternatively, if one 

is interpolating for instance out 3 meters on a GPS coarsely spaced grid, they can 

also set the total number of units to add onto the grid map start/end points using 

the slot next to the XY Round# checkbox. In this example an additional 3 meters 

is subtracted/added onto the start/end points of the grid to insure there is no 

cutoff on the map edges, should this be desired. One can also manually set the 

start/end points to any customized values without using the Help Set button. 

 

Figure 8.  New options to control grid start/end rounding and data unit additions. 

https://l.facebook.com/l.php?u=http%3A%2F%2Fwww.LearnGPR.com%2F%3Ffbclid%3DIwAR1B5fN2UdwqH8EPtS6lKHLqUnthHt8_kbc-jCL_x7P5s86o5HJziiBxhNE&h=AT2rFT1Pizm7_SWCh0J95waAe-wub_gE8yoSISmPtxEd-OT4G7tZtS1V7Hadi1sgGQdewr1A8d_bhmgH6OXLTWNFNiQkPlTtCAsjm81jzT4lWe8XGOSilY00mtMLpyG_Uarl2Mh9f2eQ07VoGw&__tn__=-UK-R&c%5b0%5d=AT2HlOfHQgvE8vYxdjAcXMZqGtC9CyRL2Pn-3_IpH2bEPBw1iOZOVwTl_2U9jWx3QMEN-46SGy8SoUIFc0eWWnC6RBPFAOSDtKC_MBiyA88_DhMdtXho7Ro2mBDPiaoL4idJddvfIDk9fMtiULkdw72c4go2pVETAbZLJ586cL2B9Wcvi1SyWINItJ-47Akd26_PgOvzrugktUAB6w


 

Figure 9.  An example GPS time slice with the XYround# engaged and via the 

Help Set button will automatically adjust grid locations to insure no cutoff edges. 

 

Parsing of long GPS radargrams 

     A new option to break up a long GPS radargram into smaller GPS radargrams is 

now available in the Radar Edit menu (Figure 10). The user will set the number of GPS 

points to parse the profile. Clicking the Parse GPS Profiles button will make radargrams 

which have N GPS points each. The last radargram will contain the remaining GPS 

points and will usually be a different size.  

     For an example, a radargram with 330 initial GPS points is broken up into segments 

that are 100 GPS points long. A total of 4 GPS profiles are generated with 3 being 100 

GPS listings and the last having 30 GPS listings (Figure 11). The segmented GPS 

radargrams are all shown to be along a continuous track in the 3D display.  Breaking 

up long GPS radargrams is not a requirement for processing but it is now available for 

those that may want to deal with shorter segments. 



 

 

Figure 10.  Location of the new option to parse a long GPS profile into 

independent profiles with N GPS points each.   The option can also be run in batch 

on an entire list of profiles within the information file. 



 

Figure 11.  An example of a GPS profile with 330 GPS points and is parsed into 

100 GPS point sections generating 4 profiles – 3 with 100 GPS point and the last 

with 30 GPS points.   The 4 parsed profiles display seamlessly in OpenGL. 



Software Update - Release of GPR-SLICE v7.MT (reposted and 

updated)  

     GPR-SLICE is a MultiThreaded – MT - application!  If you have multiple 

cores on your computer, you can speed up processing by almost N times – 

where N is the number of logical cores!   On many computers one can send 2 

threads per core for processing - where the number of logical cores can be 2 

times the number of actual cores.    When one processes a set of radargrams, 

GPR-SLICE will send out each radargram process as a separate thread to be 

executed in Windows and to be run simultaneously on as many cores as exist 

on a computer.   All-in-all, the speed of processing a set of radargrams can be 

increased almost by the number of logical cores one has on their computer!   

     

 

  

  Figure 8.  Option menu showing available and updated multithread processes.    



     The list of processes currently available are outlined in the Options menu 

(Figure 8) and include radargram filtering, radargram conversion, radargram 

editing, time slice binning and gridding operations.   Specifically:   

   

• Convert 16 bit radargrams     

• Convert 32 bit radargrams   

• Bandpass filtering   

• Background filtering    

• Diffraction stack migration   

• Kirchhoff Migration  • Hilbert Transform   

• Spectral Whitening   

• Boxcar Smoothing   

• Regain 16 bit radargrams (newly added MT operations)  

• Regain 32 bit radargrams  

• Spectral whitening  

• Cepstrum deconvolution  

• Amplitude equalization  (just added!) 

• -----   

• Inverse distance gridding   

• Kriging gridding   

• Grid Filtering 

• -----   

•  Slice binning   

• -----   

• Time 0 detection   

• Time 0 correction    

   

     These operations are the most fundamental processes and have been 

included in the recent MT release.   The desired number of cores can also be 

set and is available in the Options menu.  If you are running other applications, 

you can limit GPR-SLICE to any portion of the available logical cores so all 

active applications will run smoothly.   In addition, there can be a limit to the 

speed of operations such as when disk writing, so the user may want to test 

how many cores assigned improves the final speed of operations.   This can 

also be different with some of the processes that require different kinds of 

computer resources.   

 

 



Additional options added to GPR-SLICE Software  

  

1/9/21/ World file formats import of coordinates adjusted to handled files without carriage 
return + line feeds 

1/8/21 New Proceq GPS format for GS8000 integrated 

1/8/21 Adjustment to import Proceq dual frequency *.csv infoxy information file 

12/28/20 3D Radar SEGY multiplex format with demultiplex button operation for 
multichannel licenses added to Edit Info File menu 

12/19/20 Beta - UTM zone change along a GPS survey  - fixing all UTM zones to first UTM 
zone calculation 

12/17/20 Mala CX11 and CX12 extract/demultiplex buttons moved to the Edit Info File 
menu (with infomain.dat active) 

12/16/20 Explicit Mala Mira 8 multichannel systems with just *.cor file (and no *.pos files) 
format added 

12/15/20 Border removed from KMZ file in GPS Track menu as requested 

12/14/20 Real time mouse pointer position updated above the active radargram on multi-
radargram displays for XYpoints 

12/10/20 New *.GPS file format from Impulse Radar and using the *.time files and the *.gps 
files to interpolate synced scans (when *.cor files are not provided) 

11/30/20 Grid Help Set option to round off or not round off xy start/end points added  

11/25/20 Import of customized navigation on the XYZ to NAV button in the Edit Info File 
menu adjusted to handle files with line feed but no carriage returns written 

11/23/20 GPS track point editing option for one point, till end of track line, till start of track 
options added to GPS Track menu 

11/19/20 Appending of *.dat time slice ascii files added to the Grid menu 

11/13/20 Proceq Dual Frequency info-HF.dat and info-LF.dat auto xy information generated 
in the Create New Info menu on the Proceq infoxy2.dat listbox settings 

11/12/20 FK spectra plot axis labels added 

10/31/20 DPI aware manifests added to GPRSLICEv7.exe and GPRSLICE-animations.exe 
to auto recognize the native screen resolution without regard to Windows HI DPI setting 
engaged 

10/30/20 Improvements to Bridgedeck module where detected hyperbolas can be 
inserted/removed with the mouse 

10/28/20 Store JPG button added to the Bridgedeck module 

10/24/20 Tilted circles vector import adjusted to remove roll angle column 



10/24/20 ANG surveys now supported in the Horizon menu without having to convert to 
artificial "GPS" surveys 

10/21/20 New vector import in the Create New Info file menu for tilted circles 

10/11/20 Impulse Radar GPS log files with line feeds only and not carriage returns format 
option added 

10/7/20 Impulse Radar multichannel offsets auto-read added on the Offset File button in 
the Create New Info menu 

9/30/20 Interpolation of radargrams with unequal total number of scans - fixing to the least 
scan density profile 

9/20/20 Improved detection of active composite block turned on for transform adjustment in 
the Composite Time Slice menu 

9/9/20 Background median filter now programmed for custom filter lengths - prior was 
limited to full profile length 

9/7/20 Ditchwitch, Subsite equipment manufacturers name added to Newproject menu 

9/6/20 Custom filename import and export  vector_survey_user_set.dat data in the Create 
New Info File menu 

9/1/20 Topo warped volume now synced to volume time range and auto-cuts info files with 
longer/short time windows 

8/27/20 Normalization gain factor added to Filter menu 

8/25/20 Enhancement to Import 2D Geophysical Data for both browsing for a single input 
file or batch import via an identifier 

8/25/20 Option to convert from any manufacturers import format to GPR-SLICE format then 
in to *.dzt format in Filter menu 

8/24/20 32 to16 bit conversion buttons removed to encourage native resolution processing. 

8/19/20 Before L_to_P conversion a backup file draw_L_to_P.dat is created and can be 
used to recover lines before pipe object conversion 

8/16/20 Improved gridding and grid filtering multithread - number of active thread testing - 
and progressbar action 

8/15/20 RadarTeam to UTM button update of SEGY auto read and conversion lat/lonfrom 
double precision header location 

8/11/20 Unicode filenames conversion option in the Transfer Utility menu (to handle import 
of foreign filenames) 

8/2/20 Underscore append character identification for project import for IDS multichannel 
datasets added 

 
*This newsletter is available in *.pdf form at https://gpr-survey.com/newsletters.html   


